
Quick Start

Use GraphicsPlus to create graphical elements that add impact to your ideas. Put a GraphicsPlus object in a 
document, or save a GIF file you can add to a Web page.

To add a GraphicsPlus object to a document:

1 With the host document open, open the Gallery, if necessary, by double-clicking the GraphicsPlus icon in the 

status area of the taskbar    

2 Drag a layout from the Gallery to the spot in the document where you want the object.
3 Click Close to remove the tip.
4 Double-click the object to activate it.
5 Replace the placeholder text with your own text. 
6 If you want, change the design or color scheme of the object and enhance it using the other features of 
GraphicsPlus.
7 Click outside the GraphicsPlus object when you finish.

To create a GIF file using GraphicsPlus:

1 At the Desktop, open the Gallery by double-clicking the GraphicsPlus icon in the status area of the taskbar    

2 Double-click a layout.
3 In the GraphicsPlus window, replace the placeholder text with your own text.
4 If you want, change the design or color scheme and enhance the look using the other features of 
GraphicsPlus.
5 Click Save as GIF on the File menu.
Notes

n You can add GraphicsPlus objects to documents created with OLE2-compliant container applications. Experiment
with the programs available to you to determine the best way to add GraphicsPlus objects. If dragging a 
GraphicsPlus layout or stamp into the host document doesn't work well, try inserting the GraphicsPlus object by 
using Object on the other program's Insert menu.

n When you double-click a layout at the desktop to open the GraphicsPlus window for creating a GIF file, make 
sure no other GraphicsPlus object is active.

Related Topics
Working with the Gallery
Replacing Placeholder Text
Working with a GraphicsPlus Object
Using Layouts, Designs, Color Schemes, Stamps, and Textures
Creating an Object or a File



Intelligent Formatting

Intelligent Formatting in GraphicsPlus handles design details for you. It arranges elements on the Intelligent layer 
according to the layout and design you choose. It manages color coordination, overall size, and proportions. It selects
a font size for text based on the number and size of elements in the GraphicsPlus object. It adjusts the size of 
elements when you make changes, so everything always fits and looks balanced.

To maintain an attractive appearance when you make changes, GraphicsPlus uses regions on the Intelligent layer to 
position elements. Intelligent Formatting controls the placement of text and picture elements, but you can move them 
from one region to another.

If you want precise control of the placement of pictures, move them from the Intelligent layer to the Background layer 
or Foreground layer. Elements on the Intelligent layer appear on top of pictures on the Background layer and beneath
pictures on the Foreground layer.

Note

n To see the regions, select an element on the Intelligent layer and start to move it. If you select a text element, 
GraphicsPlus displays drop targets for text. If you select a picture, you see drop targets for pictures.

Related Topics
Layouts, Designs, Color Schemes, Stamps, and Textures
Moving or Copying Text
Moving or Copying a Picture



Layouts, Designs, Color Schemes, Stamps, and Textures

The Layouts tab shows the different ways GraphicsPlus can present your information. Layouts are based on familiar 
business idioms; choose the one that best communicates your message. For example, choose the Flow layout to 
show a sequence, or choose a Quadrant layout to compare products on two dimensions.

The Designs tab shows different arrangements of the elements in a layout, plus background elements that add visual 
interest and style. Choose a design that's right for your audience and the tone of your message. For example, choose
Boardroom for a conservative impression or Notepad for an informal effect.

The Color Schemes tab shows alternative color combinations for elements in a GraphicsPlus object. The color 
scheme determines the color of each element; the colors are coordinated to work together. Choose a color scheme 
you like that's appropriate for your distribution strategy. For example, choose a monochrome color scheme if you're 
printing on a black and white printer.
The combinations of layouts, designs, and color schemes in GraphicsPlus are nearly limitless, allowing you to avoid 
monotony and achieve just the right effect for each communication.
You can add stamps and textures to a GraphicsPlus object to further increase its impact and visual appeal.

The Stamps tab shows a collection of foreground elements that combine text with a visual to send a particular 
message. For example, add a light bulb to identify a new idea.

The Textures tab shows a collection of effects you can add to the background of a GraphicsPlus object or to certain 
elements within it. For example, show boxed text on a background of pebbles or satin.
Related Topics
Using the Tabs
Using Layouts, Designs, Color Schemes, Stamps, and Textures



Opening, Moving, Resizing, and Closing

You can open the GraphicsPlus Gallery from the Start menu or by double-clicking the GraphicsPlus icon in the status 
area of the taskbar.

When the Gallery is not maximized, it floats on your desktop. You can move the Gallery by dragging its title bar.

The width of the Gallery is fixed, but you can make it taller or shorter by dragging the top or bottom of its window. 
When maximized, the Gallery is as tall as your screen and appears at the right of your desktop.

The Gallery remains on top of other windows unless you change this preference.

Click the Close button to quit GraphicsPlus.

Related Topic
Setting Preferences



Using the Tabs

n Click a tab to see its contents.

Click: To see the:

Layouts

Designs

Color Schemes

Stamps

Textures
Related Topic
Layouts, Designs, Color Schemes, Stamps, and Textures



Using the Gallery Buttons

Use the buttons at the bottom of the Gallery to change the appearance of the current GraphicsPlus object. The first 
row contains general purpose buttons.

Click: To:

See invitations for adding text elements

Make the selected element and other elements like it bigger

Make the selected element and other elements like it smaller

Cycle through a set of styles

Cycle through a set of styles

Cycle through a set of styles

Restore the selected element to its default size and style
Note

n The buttons in the second row depend on the current layout and selection. To learn more about them, see the 
help for the current type of layout.

Related Topics
Working with Text in a GraphicsPlus Object
Changing Style
Working with Layouts



Creating an Object

You can create a GraphicsPlus object by dragging any layout from the Gallery to a host document.

To create a GraphicsPlus object:

1 If necessary, start GraphicsPlus to display the Gallery. Double-click the GraphicsPlus icon in the status area of 

the taskbar    

2 If the Layouts tab in the Gallery isn't on top, click    
3 Drag a layout from the Gallery to the place in the host document where you want the GraphicsPlus object to 
appear.

GraphicsPlus begins creating the object when you release the mouse button. The layout name flashes as the 
object is created.

4 Click Close to remove the tip.

5 Double-click the object to activate it.

6 Replace the placeholder text with your own text.

7 If you want, change the design or color scheme of the object and enhance it using the other features of 
GraphicsPlus.

8 Click outside the GraphicsPlus object when you finish.

Notes

n A host document can include more than one GraphicsPlus object, but a GraphicsPlus object can't span pages in 
the document.

n Dropping a layout onto an active GraphicsPlus object replaces all text in the object with the placeholder text for 
the new layout. Click Undo on the Edit menu of GraphicsPlus to restore the previous layout and text.

Related Topics
Working with the Gallery
Replacing Placeholder Text
Working with a GraphicsPlus Object
Using Layouts, Designs, Color Schemes, Stamps, and Textures



Creating a GIF File

You can use GraphicsPlus to create a GIF file that you can add to a Web page. Before you begin, make sure no other
GraphicsPlus object is active.

1 At the Desktop, open the Gallery by double-clicking the GraphicsPlus icon in the status area of the taskbar    

2 Double-click a layout.
3 In the GraphicsPlus window, replace the placeholder text with your own text.
4 If you want, change the design or color scheme and enhance the look using the other features of 
GraphicsPlus.
5 Click Save as GIF on the File menu.
Notes

n To edit the GIF file, use an application that edits pictures saved in GIF format.

n To make the GIF file appear larger or smaller in the Web page, resize the GraphicsPlus object in its window and 
save the file again. If necessary, make the window larger before resizing the object. The size of the object is 
displayed in pixels at the lower-right of the window. The first number is the width of the object; the second number
is the object's height.

n In the GraphicsPlus window, you can print a GraphicsPlus object before saving it as a GIF file.

n You can also save the object as a GraphicsPlus file. To open the file later, use the Open command on the File 
menu in the GraphicsPlus window. To open the GraphicsPlus window, complete steps one and two of this 
procedure.

Related Topics
Working with the Gallery
Replacing Placeholder Text
Working with a GraphicsPlus Object
Using Layouts, Designs, Color Schemes, Stamps, and Textures



Creating an Object or a File

Click the topic you want help on.

n Creating an Object

n Creating a GIF File



Investigating the Layouts

GraphicsPlus includes a great variety of layouts, which are organized in categories for quick access. Some layouts 
provide additional alternatives as variations. This topic gives suggestions for:

n Deciding which layout to choose

n Navigating between layout categories

n Displaying layout variations

To read about the purpose of specific layouts:

1 Drag a layout into the host document to create a new GraphicsPlus object. Double-click the new object to activate
it.

2 Click    

3 If Transparent is the current design, click another design to see additional placeholder text in the object.
4 Read, but don't change, the placeholder text.

5 To see the purpose of another layout, click    
6 Click the layout you're interested in and read its placeholder text.
To navigate quickly between categories in the Gallery:

n To hide the layouts and display only the category headings, click a category heading.

n To see all the layouts when the categories are collapsed, click any category heading.

To display layout variations:

n Click the small triangle to the right of a layout to see its variations.    

n To close the variations, click the small triangle again. You can also close variations by clicking the variation 
heading, clicking one of the small circles to the right of the variations, or displaying the variations of another layout.
Note

n If you choose a variation and then close the variations for the layout, GraphicsPlus substitutes your chosen 
variation for the layout. For example, display the variations for the Pie layout, click 3-D, and then close the Pie 
variations. The picture of the 3-D pie replaces the picture of the basic pie; when you choose the Pie layout, 
GraphicsPlus uses the 3-D variation instead of the basic pie.

Related Topic
Changing an Object's Layout, Design, or Color Scheme



Choosing a Design

GraphicsPlus objects can be transparent or opaque. An object with the Transparent design merges into the host 
document. When inactive and not selected, it has a transparent background and no border. GraphicsPlus objects with
other designs have a visible border and background.

The default design of a GraphicsPlus object is Boardroom. Of course, you can change the design after you create an 
object. Choose a design that's appropriate for your audience and the tone of your message.

Note

n By default, GraphicsPlus objects created with a Transparent design do not have a title or subtitle. You can add 
these elements using the Text command on the Insert menu of GraphicsPlus.

Related Topics
Adding Texture
Changing an Object's Layout, Design, or Color Scheme



Choosing a Color Scheme

GraphicsPlus provides three types of color schemes: monochrome, light background, and dark background. You can 
easily identify the colors used in a particular scheme by looking at the picture to the left of the color scheme's name in
the Gallery. The color of the palette is the background color.

Keep these points in mind when you choose a color scheme:

n Black and white printing:    Use a monochrome color scheme if you'll be printing a document that contains a 
GraphicsPlus object on a printer that doesn't support color.

n Avoiding curl and bleed:    Some printers jam from curled paper; others use ink that bleeds through the paper. If 
you've experienced these problems with your color printer, choose a light background for GraphicsPlus objects.

n Recording on film:    If you're creating slides that include GraphicsPlus objects, remember that text on a light 
background is harder to read when projected. Use a color scheme with a dark background for the object.

Notes

n The default color scheme is USA. You can easily change a GraphicsPlus object's color scheme.

n If a GraphicsPlus object has the Transparent design, its Background layer is the same color as the background of
the host document. The color of text that sits directly on the background is not controlled by the current color 
scheme. To be readable, text is black on a light background and white on a dark background.

Related Topic
Changing an Object's Layout, Design, or Color Scheme



Adding Stamps

Stamps can add pizzazz to a document. This topic gives suggestions for:

n Creating a stamp

n Resizing and moving a stamp

n Changing an existing stamp into another stamp

To create a stamp:

1 If the Stamps tab isn't on top, click    

2 Drag a stamp from the Gallery into a GraphicsPlus object, or a host document. 
3 Type your text, replacing the placeholder text.
4 When you finish typing, click outside the stamp.
To resize a stamp:

1 If the stamp isn't selected, click it anywhere except on its text.

2 Drag a handle to change the stamp's size.

To move a stamp:

1 If the stamp isn't selected, click it anywhere except on its text.

2 Drag the stamp to the new location.

To change a stamp to another stamp:

1 If the stamp isn't selected, click it.

2 Click the stamp you want to change to in the Gallery.

Notes

n When you add a stamp to a GraphicsPlus object, the stamp appears on the Foreground layer at the location 
where it was dropped.

n If you drop a stamp directly into a host document, GraphicsPlus creates a new object that contains only the 
stamp. You can change this object's design, color scheme, or texture.

n Immediately after they're added to a host document, several stamps have no placeholder text. You can add text 
to these stamps.

n To add text with no background to a GraphicsPlus object in a position that is not supported by Intelligent 
Formatting, use the Plain Text stamp.

n To return to the stamp's original size, select the stamp if necessary by clicking it, and then click    

n Make sure a GraphicsPlus object that contains only a stamp is active before attempting to change it. 
Double-click the stamp to activate it, if necessary.
Related Topics
Intelligent Formatting
Replacing Placeholder Text



Adding Texture

To add texture to the background of a GraphicsPlus object:

1 If the Textures tab isn't on top, click    

2 Click a texture.
To add texture to the background and all elements that accept texture:

n Hold down the CTRL key when you click a texture.

Notes

n You can also add texture to the elements that accept texture and not to the background. Elements that accept 
texture include, for example, tables, positions in an Org Chart, satellites in an Orbit layout, or the boxes around 
text in some designs. Drag a texture and drop it on the element. If you drop a texture on a boxed point, 
GraphicsPlus adds texture to all the points at that level.

n To remove a texture, use the Clear texture.

n Chart elements (for example, bars, pie slices, and areas) do not accept texture.

n GraphicsPlus objects with the Transparent design don't display texture in their background. Clicking a texture in 
the Gallery when one of these objects is active adds texture to any elements in the object that accept texture.

n If you change designs after adding a texture to the box around text, you won't see the texture if the text isn't 
boxed in the new design. The texture reappears if you switch to a design with boxed text.



Setting Preferences

1 Click the title bar of the Gallery with the right mouse button.

2 Click Customize.

3 Change the settings to match your preferences.

Click: To:

Show ToolTips Display or hide ToolTips when the pointer is on a button or tab in the Gallery and the 
Gallery is active

Always on Top Float the Gallery on top of or behind other windows

Always Run Editor When you double-click the GraphicsPlus icon, display the GraphicsPlus window and 
Gallery, or only the Gallery.

A Color button Turn dithering on or off

Notes

n Have Always Run Editor unchecked if you usually create GraphicsPlus objects in host documents.

n Dithering is off by default so that GraphicsPlus objects look as good as possible when they're printed.

On a system with a display set for 256 colors or less, dithering can improve the onscreen appearance of an 
inactive GraphicsPlus object. Without dithering, bands can appear in gradients and textures. To prevent this 
banding, you can set GraphicsPlus to dither colors on these systems. If you turn dithering on, be sure to turn it off
and remove dithering from any GraphicsPlus objects before printing them.

If it's turned on, dithering occurs when you de-activate a GraphicsPlus object. To remove dithering from existing 
objects after you turn dithering off, activate (if necessary) and de-activate each object. To de-activate a 
GraphicsPlus object, click on the host document outside the object.

Related Topic
Activating a GraphicsPlus Object



Working with the Gallery

Click the topic you want help on.

n Opening, Moving, Resizing, and Closing

n Using the Tabs

n Using the Gallery Buttons



Using Layouts, Designs, Color Schemes, Stamps, and Textures

Click the topic you want help on.

n Investigating the Layouts

n Choosing a Design

n Choosing a Color Scheme

n Adding Stamps

n Adding Texture





Adding Puzzle Pieces

1 Click the text of an existing puzzle piece.

2 Press ENTER.

3 Type the text for the new piece.

4 Click the background of the GraphicsPlus object when you finish typing.

5 Drag the new piece into position.

Notes

n To move a piece, select it, if necessary, by clicking anywhere except on its text. Then, drag the selected piece to 
another location.

n To change the size or shape of a piece, select it if necessary, and then drag a handle on its bounding outline.

n Puzzle pieces are intended to represent related, but independent concepts; they don't fit together. If you want to 
show interlocking puzzle pieces, use the Puzzle layout.



Changing Ratings

n Click the cell with the rating you want to change.

Note

n For the Circles and Diamonds layouts, click the cell repeatedly to cycle through the rating alternatives.

For: Click to see:

Circles No circle, empty circle, half-filled circle, filled circle

Diamonds Zero to four diamonds



Editing a Quadrant Layout

To move an entry:

n Drag the entry to the new position.

To change the size or shape of a region:

n Click the region if it's not selected, and drag a handle on its bounding outline.

To remove an axis from a layout with one quadrant:

n Delete all axis labels.

Notes

n If entries overlap, you can change their order. Click an entry to select it and then:

Click: To move the entry toward the:

Top of the stack of entries

Bottom of the stack
n If you remove the labels, GraphicsPlus maintains the axes of layouts with four quadrants.

n To restore an axis you removed, click the Insert button in the Gallery and type a label at the appropriate invitation.



Editing Data in a Stock Arrows Layout

1 Click the value you want to change.

2 Make changes in the edit box.

3 Click the background of the GraphicsPlus object when you finish editing the data.

Note

n To add a note to the right of a stock arrow, click the stock's name. Then, click the Insert button and type the note 
at the sub-point invitation. Click the background of the GraphicsPlus object when you finish typing.



Editing Data in a Stock Table

1 Click the cell you want to change.

2 Make changes in the edit box.

3 Click the background of the GraphicsPlus object when you finish editing.

Note

n To change the value in a Volume cell, click the cell, type the new value, and click the background.



Adding a Row or Column to a Table

To add a row to a table:

1 Click a cell in the row below where you want the new row.

2 Click    

3 Click the invitation for a new row.
4 Type your text or data, replacing the placeholder text.
5 Press the RIGHT ARROW key and type the contents for the next cell.
6 Continue pressing the RIGHT ARROW key and typing until the row is complete.
7 Click the background of the GraphicsPlus object when you finish typing.
To add a column to a table:

1 Click a cell in the column to the right of where you want the new column.

2 Click    

3 Click the invitation for a new column.
4 Type your text or data, replacing the placeholder text.
5 Press the DOWN ARROW key and type the contents for the next cell.
6 Continue pressing the DOWN ARROW key and typing until the column is complete.
7 Click the background of the GraphicsPlus object when you finish typing.
Notes

n To add a row after the last row, click in the first cell of the last row and press ENTER.

n To add a column after the last column, click in the first cell of the last column and press ENTER.

n To delete a row or column, select the text or data in the first cell of the row or column and press DEL.



Transposing a Table

n Click    

Note

n Clicking the Flip button swaps rows and columns in the table.



Reviewing or Adding Chart Data

To review chart data:

1 Click    

2 Click the Show Chart as Table button again when you finish examining the data.
To add data to a chart:

1 Click    

2 Add a row or column to the table, as appropriate.
3 Click the Show Chart as Table button again when you finish adding the data.
Note

n You can also add data directly to the chart by clicking a chart element and then pressing ENTER.

Related Topics
Adding a Row or Column to a Table
Editing Data Values and Labels
Changing the Display of Data Values



Editing Data Values and Labels

1 Click the value or label you want to change.

2 Type your change.

3 Click the background of the GraphicsPlus object when you finish typing.

Note

n If you want to make many changes, it may be easier to switch to a table layout before editing.

Related Topics
Reviewing or Adding Chart Data
Changing the Display of Data Values



Changing the Display of Data Values

n Click the Values button.

Notes

n The appearance and action of the Values button depend on the type of chart.

Click: To:

Show or hide data values for Bar, Column, Line, and Area charts

Cycle through the alternatives for Proportional Bar and Column charts, Pie charts, and Pyramid charts. You 
see values only, both values and percentages, percentages only, or neither values or percentages
n Click the Values button repeatedly to see the alternatives.

Related Topics
Editing Data Values and Labels
Reviewing or Adding Chart Data
Changing Style



Showing or Hiding a Legend

n Click    

Notes

n Pie and Pyramid charts don't have legends.

n Click the legend title region to add a legend title. Click the title to edit it.



Rotating a Chart

n Click    

Notes

n Click the Rotate button repeatedly to cycle through different rotation angles.

n You can rotate Pie charts and the 3-D varieties of Bar, Column, Line, and Pyramid charts.



Separating a Pie Slice

1 Click the slice you want to separate.

2 Click    

Notes

n Repeat these steps to return the slice to the pie.

n The Slice button is not available for separated variations of the Pie layout.



Transposing the Axes of a Bar or Column Chart

n Click    

Note

n Clicking the Flip button swaps the dimension shown in the chart's legend for the dimension shown on the non-
numeric axis.



Checking Off Items on a To Do List

n Click the box in front of the item. Click again to remove the check mark.



Changing the Day, Week, or Month

1 Click the element you want to change.

2 Make changes in the edit box.

3 Click the background of the GraphicsPlus object when you finish editing.

Notes

n To change a time period in the Agenda layout, click it and type your change.

n You can set any date in the Week layout. GraphicsPlus displays the dates for the Sunday and Saturday of the 
appropriate week.

n In the Day, Week, Month, or Month Overview layout, you can quickly change to the previous or next day, week, or
month:

Click: For the:

Previous day, week, or month

Next day, week, or month
n GraphicsPlus uses the Regional Settings from the Windows Control Panel for displaying dates. Use the Control 

Panel to change date format.



Highlighting a Date in a Month

To highlight a date in the Month layout:

1 Click below the number of the date you want to highlight.

If the date has an appointment, click the appointment.

2 Click    

To highlight a date in the Month Overview layout:

n Click the date you want to highlight.

Notes

n You can highlight more than one date.

n To remove a highlight, repeat the steps for adding the highlight.



Enhancing a Time Line Layout

To change the appearance of the bar below the events:

n Click    

To add glyphs to the events:

1 Click an event.

2 Click    

Note

n Glyphs appear to the left of the event names.



Editing a Gantt Chart Layout

To change the starting date or duration of a task:

1 Click the task with the right mouse button.

2 Click Start and Duration.

3 Make changes in the edit box.

4 Click OK.

To add a task:

1 Click the name of the task that's above the position where you want the new task.

2 Press ENTER.

3 Type a name for the new task.

4 Press TAB.

5 Make changes in the edit box.

6 Click the background of the GraphicsPlus object when you finish editing.

To display a milestone:

n Click a task's duration and set it to zero.

To change the appearance of the bar containing the dates:

n Click    

To change the appearance of the duration bars:

1 Make sure you have not clicked a duration bar.

2 Click    

To add glyphs to the events:

1 Click an event.

2 Click    

Notes

n To change the starting date of the chart, change the starting date of the first task. You can set any date as the 
starting date. GraphicsPlus calculates the end date based on the duration of the tasks.

n Milestones appear as a diamonds.

n Clicking the Style button changes the glyph when the insertion point is in a task or a task's name is selected.

Related Topic
Moving or Copying Text



Saving a Custom Layout

1 Create a GraphicsPlus object that has the layout you want as the basis for the custom layout.

2 Change the design and color scheme of this object, if you want.

3 Add to the object any stamps, textures, pictures, or text you want to appear in the custom layout.

4 Click the GraphicsPlus object with the right mouse button.

5 Click Add to Custom.

6 Type a name for the custom layout and click Add.

Notes

n The new custom layout appears in the Custom category in the Gallery's Layouts tab. GraphicsPlus creates this 
category when you save the first custom layout; it removes the category if you delete the last custom layout.

n To maintain an attractive look for the list of layouts in the Gallery, type a short name for a custom layout (under 
about 20 characters).

n To delete a custom layout, click the layout's name with the right mouse button and then click Delete.

n GraphicsPlus saves a custom layout in a file in the Custom subfolder of the folder where you installed 
GraphicsPlus. You can rename a custom layout by changing the name of its file. If you rename a custom layout 
file, keep the name short, and don't change the number or filename extension.

Related Topics
Creating an Object
Working with a GraphicsPlus Object



Working with Layouts

Click the topic you want help on.

Relationships

n Adding Puzzle Pieces

Comparisons

n Changing Ratings

n Editing a Quadrant Layout

n Editing Data in a Stock Arrows Layout

n Editing Data in a Stock Table

Tables

n Adding a Row or Column to a Table

n Transposing a Table

Charts

n Reviewing or Adding Chart Data

n Editing Data Values and Labels

n Changing the Display of Data Values

n Showing or Hiding a Legend

n Rotating a Chart

n Separating a Pie Slice

n Transposing the Axes of a Bar or Column Chart

Lists

n Checking Off Items on a To Do List

Scheduling

n Changing the Day, Week, or Month

n Highlighting a Date in a Month

n Enhancing a Time Line Layout

n Editing a Gantt Chart Layout

Custom

n Saving a Custom Layout





Activating a GraphicsPlus Object

n Double-click a GraphicsPlus object in the host document to make changes to the object.

Notes

n When a GraphicsPlus object is active, its border in the host document is wider, and its menus replace many of 
the host application's menus.

n Most other GraphicsPlus help topics begin with the assumption that the GraphicsPlus object is active.

Related Topic
Changing an Object's Layout, Design, or Color Scheme



Changing an Object's Layout, Design, or Color Scheme

1 Double-click the GraphicsPlus object to activate it, if necessary.

2 Click the appropriate tab in the Gallery.

Click: To change the:

Layout

Design

Color Scheme
3 Click the layout, design, or color scheme you want to change to.

Notes

n If you're changing layouts, be sure to pick a layout that corresponds to your data.

n If you switch from the Transparent design to another design or the reverse, GraphicsPlus may add or remove 
placeholder text. Also, a texture you've added to the background of the object may appear or disappear.

Related Topic
Using Layouts, Designs, Color Schemes, Stamps, and Textures



Resizing a GraphicsPlus Object

1 If the GraphicsPlus object is not selected, click it.

2 Drag a handle on the object's bounding outline.

Notes

n To restore the default size after resizing a GraphicsPlus object, click the current layout again.

n The size and shape of GraphicsPlus objects with the Transparent design are affected by the setting for Fit 
Contents. When Fit Contents is checked, GraphicsPlus removes unused space around elements in the object. 
When you add or remove elements, GraphicsPlus changes the object's size as necessary to just fit its contents.

n The size and shape of a GraphicsPlus object with a design other than Transparent are not affected by the object's
contents. When you add or remove elements, Intelligent Formatting scales the contents to fit inside the object.

n If Fit Contents is off for a transparent object, GraphicsPlus treats it like an object with another design. You can 
see the setting for Fit Contents by clicking a transparent object with the right mouse button. Fit Contents 
appears on the menu only for objects with the Transparent design.

n A GraphicsPlus object must fit on a single page in the host document.



Adding or Removing the Background and Border

1 If the Designs tab isn't on top, click    

2 Change the design.

To: Click:

Remove the background and border The Transparent design

Add a background and border Another design

Related Topic
Layouts, Designs, Color Schemes, Stamps, and Textures



Changing Style

n Click the Style button.

Notes

n The appearance and action of the Style button depend on the layout of the GraphicsPlus object and what's 
selected in it.

Click: To change the:

Glyph

Look of boxes that contain text when no text is selected

Appearance of such things as bars, axes, axis labels, and the background area within the axes.
n All designs have a default style that overrides the current style settings. You can use the Style button to make 

changes to the default style of most designs.

n To return to the default style, click    

n Clicking the Reset button also restores default sizes and resets changes made with several other buttons.
n The Style button is not available for some layouts.



Modifying a GraphicsPlus Object

Click the topic you want help on.

n Activating a GraphicsPlus Object

n Changing an Object's Layout, Design, or Color Scheme

n Resizing a GraphicsPlus Object

n Adding or Removing the Background and Border

n Changing Style



Replacing Placeholder Text

1 Click the first placeholder text element to select it.

2 Type your text and press TAB.

3 Continue typing text and pressing TAB until you type all your information.

4 Click the background of the GraphicsPlus object when you finish typing.

Notes

n To delete unneeded placeholder text, click it and press DELETE.

n To delete all placeholder text after you have replaced one or more placeholders, click Turn Off Placeholders on 
the GraphicsPlus Edit menu. Click Turn On Placeholders to restore placeholder text.

n For the Day, Week, and Month layouts, you can use Turn Off Placeholders to remove all placeholder text before
replacing any placeholders. Turn Off Placeholders is not available for Chart layouts.

Related Topics
Adding a Point or Sub-point
Adding a Title, Subtitle, Remark, or Lead-in



Editing Text

To insert text in existing text:

n Click where you want to insert and begin typing.

To change existing text:

n Drag to select the text you want to change; then type the change, or press CTRL+V to paste text from the 
clipboard.

To split a point into two points:

n Click where you want the second point to begin and press CTRL+DOWN ARROW.

To merge two points:

n Click the second point and press CTRL+UP ARROW.

To delete a text element:

n Select all of the element's text and press DELETE.

To start a new line within a point:

n Click where you want the new line to begin and press SHIFT+ENTER.

Notes

n To select all the text in a text element, click just to the left of the element. You can also select all the text by 
dragging. Press TAB or SHIFT+TAB to select the next or previous element.

n When you finish editing, click the background of the GraphicsPlus object.

n To undo editing changes, click Undo on the Edit menu in GraphicsPlus.

n Don't be concerned with where lines end when you edit text. GraphicsPlus adjusts line breaks when you finish 
editing. If you want a line break at a particular place, you can add it with SHIFT+ENTER.

n Some points don't support splitting or merging.

Related Topic
Working with Text in a GraphicsPlus Object



Adding a Point or Sub-point

To add a point:

1 Click the point above or before where you want to make the addition.

2 Press ENTER.

3 Type the text for the new point.

4 Click the background of the GraphicsPlus object when you finish typing.

To add a sub-point:

1 Click the point you want to add a sub-point to.

2 Press CTRL+ENTER.

3 Type the text for the sub-point.

4 Click the background of the GraphicsPlus object when you finish typing.

Notes

n To add more points or sub-points, press ENTER when you finish typing instead of clicking the background.

n To add another sub-point to a point that already has sub-points, click an existing sub-point and press ENTER.

n To add a point before an existing point, click the existing point and then click    

When you click the button, an invitation for adding a new point appears before a selected point, or at the end of 
the body if no point is selected.

n To split an existing point into two points, click where you want the new point to begin and press CTRL+DOWN 
ARROW.

n You can also add a point using the Insert menu.

n You can't add points or sub-points after some points.

Related Topics
Changing the Indent of a Point or Sub-point
Adding a Title, Subtitle, Remark, or Lead-in



Adding a Title, Subtitle, Remark, or Lead-in

1 Click the Insert menu, and then click Text.

2 Click the element you want to add.

3 Type your text, replacing the placeholder text.

4 Click the background of the GraphicsPlus object when you finish typing.

Notes

n The available choices on the Text submenu of the Insert menu depend on the design of the active GraphicsPlus 
object and what elements it contains.

n You can use the Insert button to add most text elements to most designs, but use the Text command on the 
Insert menu to add a title or subtitle to an object with the Transparent design.



Changing the Size of Text

1 Click the text you want to change.

2 Click a button to change the size.

Click: To:

Make the text larger

Make the text smaller
Notes

n If you're changing the size of points or sub-points, select just one of them. GraphicsPlus changes all the points at 
the same level.

n If no text is selected, the Bigger and Smaller buttons change the size of body text.

n To make text as large as possible, hold down the CTRL key when you click the Bigger button.

n You can fix unattractive line breaks by changing the size of the text. For example, make text smaller to move a 
single word on the last line up to the previous line.

n When you change text size, GraphicsPlus adjusts the size of other items on the Intelligent layer.

n To return to the original size, click    

n Clicking the Reset button also restores the default style and resets changes made with several other 
buttons.
Related Topics
Resizing a GraphicsPlus Object
Changing Style



Moving or Copying Text

To move text:

1 Move the pointer to the left of the text until the pointer changes to an arrow that points to the right.

2 When you see the right-pointing arrow, drag the text to the new location.

3 Release the mouse button to drop the text.

If you're moving: Drop the text:

Within the body At the new location

Outside the body On one of the drop targets that appear on the Intelligent layer

To copy text:

1 Hold down the CTRL key while you drag the text.

2 Drop the copy as if you had moved it.

Notes

n When you move or copy a point, its sub-points stay with it.

n Text is restricted to the Intelligent layer; you can't move it to the Background layer or Foreground layer. To put text
on the Foreground layer, add a Plain Text stamp.

n You can also use the Cut or Copy and Paste commands on the Edit menu to move or copy a point.

Related Topics
Changing the Indent of a Point or Sub-point
Intelligent Formatting
Adding Stamps



Changing the Font

1 Click Font on the Edit menu in GraphicsPlus.

2 Click the new font and then click OK.

Note

n You can set only one font at a time for a GraphicsPlus object.



Changing the Indent of a Point or Sub-point

To promote (move left):

1 Click the point or sub-point.

2 Press CTRL+LEFT ARROW.

To demote (move right):

1 Click the point or sub-point.

2 Press CTRL+RIGHT ARROW.

Note

n You can also drag the point or sub-point to the new indentation.



Working with Text in a GraphicsPlus Object

Click the topic you want help on.

n Replacing Placeholder Text

n Editing Text

n Adding a Point or Sub-point

n Adding a Title, Subtitle, Remark, or Lead-in

n Changing the Size of Text

n Moving or Copying Text

n Changing the Font

n Changing the Indent of a Point or Sub-point



Adding a Picture

1 Click Picture on the Insert menu in GraphicsPlus.

2 Select the picture file and click Open.

Notes

n GraphicsPlus adds a picture to the Intelligent layer at the right of the body, You can move or resize the picture.

n Your picture file can be in one of these formats:

Windows Metafile (.wmf)
Windows Bitmap (.bmp, .dib)
Tagged Image Format (.tif)
CompuServe Picture (.gif)
PC Paintbrush (.pcx)

n To add Microsoft clip art, click ClipArt on the Insert menu in GraphicsPlus. This command is available if the 
Microsoft ClipArt Gallery is installed on your computer. If you need help using the ClipArt Gallery, click its Help 
button.

Related Topics
Moving or Copying a Picture
Changing the Size of a Picture
Creating a Background from a Picture
Adding an OLE Object



Creating a Background from a Picture

1 Click the picture.

2 Click    

Notes

n When you put a picture on the Background layer, handles appear so you can resize it.

n GraphicsPlus scales a picture on the Background layer to fill the GraphicsPlus object. Set Normal scaling if the 
picture appears distorted.

n When a picture on the Background layer fills the GraphicsPlus object, text on the Intelligent layer appears on top 
of the picture and might be difficult to read. To make text on top of a bitmap more visible, click the picture and 

then click    

n To restore the original colors, click the picture and then click the Fade Colors button again.

n You can also resize and move a picture on the Background layer so text does not appear on top of the picture.

n To tint a bitmap picture on the Background layer to match the color scheme of the GraphicsPlus object, click   

Related Topics
Adding a Picture
Changing the Size of a Picture
Moving or Copying a Picture
Changing Scale Options



Moving or Copying a Picture

The way you move or copy a picture depends on whether it's on the Intelligent layer, the Foreground layer, or the 
Background layer.

To move a picture on the Intelligent layer:

n Drag the picture to a drop target.

To move a picture from the Intelligent layer to the Foreground or Background layer:

1 If the picture isn't selected, click it.

2 Click a button to indicate the destination.

Click: To move to the:

Foreground layer

Background layer
To move a picture on the Foreground or Background layer:

n Drag the picture to a new location.

To copy a picture on the Intelligent layer:

n Hold down the CTRL key as you drag.

To copy a picture on the Foreground or Background layer:

n Use Copy and Paste on the Edit menu. 

GraphicsPlus pastes a copied picture on top of the original picture. Drag the copy to its new position.

Notes

n GraphicsPlus restricts the placement of pictures on the Intelligent layer, but you can drag a picture anywhere on 
the Foreground or Background layer.

n To determine which layer a picture is on, make sure it's selected and check which placement button is depressed.
Click the picture to select it, if necessary.

n If two or more pictures share the same region on the Intelligent layer, you can change their alignment in relation 
to one another.

n When you move or copy a picture on the Intelligent layer, GraphicsPlus adjusts the picture's size and the size of 
other elements on the layer.

n When you move a picture to the Background layer, GraphicsPlus resizes it to fill the layer.

n If you move a picture, its caption moves with it.

Related Topics
Intelligent Formatting
Changing the Size of a Picture
Changing the Alignment of Pictures
Adding a Caption to a Picture



Changing the Size of a Picture

To change the size of a picture:

1 If the picture isn't selected, click it.

2 Click a button to change the size.

Click: To:

Make the picture larger

Make the picture smaller
Notes

n If a selected picture is on the Foreground layer or Background layer, you can also change its size by dragging a 
handle at the corner of the picture.

n To change the proportions of a selected picture on the Foreground or Background layer, set the picture's scale 
option to Stretch and drag a handle on a side of the picture.

Related Topic
Changing Scale Options



Adding a Caption to a Picture

1 If it's not already selected, click the picture you want to add a caption to.

2 Press ENTER.

3 Type your caption over the placeholder text and press ENTER.



Changing Scale Options

1 Use the right mouse button to click a picture on the Intelligent layer,

2 Click Properties.

3 Set the scaling.

Set: To:

Normal Maintain the original picture's proportions

Stretch Fill the region with the picture

None Remove any scaling from a bitmap

4 Click OK.

Notes

n Set Normal scaling to allow GraphicsPlus to control the size of the picture. Depending on its placement, the size 
of the picture might change, but its proportions remain the same.

n Set None for a bitmap file, like a logo, that you don't want GraphicsPlus to scale. The picture's size is determined 
by the number of pixels in its height and width. The size might change depending on the resolution of the output 
device (printer or screen), but does not vary with placement.

n If you set Stretch, you can change the proportions of a picture placed on the Foreground layer or Background 
layer by dragging the handle on a side of the picture.

Related Topic
Changing the Alignment of Pictures



Changing the Alignment of Pictures

1 Click one of the pictures in a region with the right mouse button.

2 Click Properties.

3 Set the alignment.

Set: To align the pictures:

Vertical From top to bottom

Horizontal Side by side

Stack In a stack so only the top one shows completely

4 Click OK.

Note

n The Alignment buttons set the position of a picture in relation to other pictures in the same region on the 
Intelligent layer.

Related Topic
Changing Scale Options



Adding an OLE Object

1 Click Object on the Insert menu.

2 Set a create button.

Set: To:

Create New Create a new OLE object

Create from File Insert an existing object file

3 Set options in the dialog box.

If you set: Do this:

Create New Click the program you'll use to create the OLE object

Create from File Select an existing file. (Click Browse to locate the file.)
To link the OLE object in the GraphicsPlus object with the OLE object's file, set Link

4 Click OK.

Notes

n To edit an OLE object, double-click it in the GraphicsPlus object.

n If you don't set Link, you put a copy of the OLE object file in the GraphicsPlus object. Changes you make in this 
copy don't appear in the original file, and changes in the original file don't appear in the copy. Don't set Link if you
plan to distribute the host document or display it on a different computer.

n You can also add an OLE object by copying it in the source program and clicking Paste Special on the Edit menu
in GraphicsPlus.

Related Topics
Moving or Copying a Picture
Changing the Size of a Picture



Working with Pictures in a GraphicsPlus Object

Click the topic you want help on.

n Adding a Picture

n Creating a Background from a Picture

n Moving or Copying a Picture

n Changing the Size of a Picture

n Adding a Caption to a Picture

n Changing Scale Options

n Changing the Alignment of Pictures

n Adding an OLE Object



Working with a GraphicsPlus Object

Click the topic you want help on.

n Modifying a GraphicsPlus Object

n Working with Text in a GraphicsPlus Object

n Working with Pictures in a GraphicsPlus Object





Definitions

Click a word to see its definition.

Background layer
body
caption
category
Color Scheme
Design
dither
drop targets
element
embed
Foreground layer
Gallery
glyph
host application
host document
invitation
Intelligent Formatting
Intelligent layer
Layout
lead-in
link
logo
OLE object
picture
pixel
placeholder text
point
region
remark
Stamp
style
sub-point
Texture
Transparent design
variation
GraphicsPlus icon
GraphicsPlus object
GraphicsPlus window



Background layer

The underlying layer of a GraphicsPlus object. Elements on the Intelligent layer and Foreground layer appear on top 
of the Background layer.



body
The main region of a GraphicsPlus object that contains points and sub-points.



caption
Text you can add to a picture in a GraphicsPlus object. A caption appears below the picture. If you move 
the picture, the caption moves with it.



category

A collection of layouts having a common purpose. For example, the Charts category includes layouts for graphically 
representing data--bar charts, pie charts, line charts, and more.



Color Scheme

A choice on the third tab of the GraphicsPlus Gallery. Color schemes select and coordinate the colors used in 
GraphicsPlus objects.



Design

A choice on the second tab of the GraphicsPlus Gallery. Designs determine the overall appearance of a GraphicsPlus
object. Each design ensures that all elements in the object are positioned to look balanced and in proportion.



dither
To combine dots of different colors to create the illusion of another color.



drop targets
Phrases or symbols that identify available destinations when you drag elements on the Intelligent layer. 
Phrases appear for text; small rectangular symbols appear for pictures.



element
A component of a GraphicsPlus object. Text, pictures, tables, charts, and other graphic components of 
the layouts (for example, a pyramid or a flow diagram) are elements.



embed
To add an object created by another program to a GraphicsPlus object. You can use the original program 
to edit the embedded object within the GraphicsPlus object. Embedded objects are not linked to a file 
created by another program.



Foreground layer

The surface layer of a GraphicsPlus object. Elements on the Intelligent layer and Background layer appear beneath 
the Foreground layer.



Gallery
The window containing the tabs, list, and buttons you use to create or change a GraphicsPlus object.



glyph
The number, check mark, or bullet preceding text in some layouts. Bullets can be diamonds, triangles, 
squares, circles, and dashes.



host application
The program in which you create a GraphicsPlus object.



host document
A document created in a host application in which you include a GraphicsPlus object.



Intelligent Formatting
The graphic design intelligence built into GraphicsPlus that arranges and scales text and pictures in a 
GraphicsPlus object. Regardless of changes, Intelligent Formatting keeps elements in the object looking 
balanced and in proportion.



Intelligent layer

A “transparent” layer in a GraphicsPlus object, where the selected layout and design determine the size and 
placement of elements. The Intelligent layer appears between the Background layer and the Foreground layer.



Invitation
Text that appears in the active GraphicsPlus object when you click the Insert button in the GraphicsPlus 
Gallery. Invitations indicate which elements you can add to the GraphicsPlus object and where to type 
text for these elements.



Layout

A choice on the first tab of the GraphicsPlus Gallery. Layouts arrange and display information in a GraphicsPlus 
object according to the concept being conveyed. Choose a layout that reinforces the message you want to 
communicate.



lead-in
Text you can add to the bottom-right of a GraphicsPlus object.



link
To create a connection between an object from another program and an element in a GraphicsPlus 
object.



logo
A distinctive symbol or graphic representing a company, product, or the like. In GraphicsPlus, a logo is a 
picture that you can add to the left of the title.



OLE object
A component that is created with one program and added to a document created by another program. 
You can embed or link the OLE object when you add it. GraphicsPlus objects in host documents are OLE
objects; you can add an OLE object to a GraphicsPlus object.



picture
A graphic image that can be added to a GraphicsPlus object. A picture can be Microsoft ClipArt or a file in
any of the following formats:    Windows Metafile (.wmf), Windows Bitmap (.bmp, .dib), Tagged Image File
Format (.tif), CompuServe Picture (.gif), or PC Paintbrush (.pcx).



pixel
Picture element. The smallest element of a computer screen that can be assigned color. The greater the 
number of pixels, the better the clarity of a picture.



placeholder text
Built-in, helpful text supplied by GraphicsPlus. You replace it with the actual text you want to appear in 
the object.



point
An element covering a detail about the main idea conveyed by the GraphicsPlus object. Points represent 
different items in different layouts. For example:

Layout: Point:
Headings a heading
Org Chart a position
Flow a step
Quadrant a product
Table a row or column
Pie Chart a slice
Column Chart a series or a column
Bullets an item in the list
Time Line an event
Gantt Chart a task



region
An area of the Intelligent layer. Text regions include title, subtitle, top remark, bottom remark, body, and 
lead-in. Picture regions include relative locations on the page, such as top, bottom, upper left, and lower 
left. Not all designs have every region.



remark
Text you can add to the top or bottom of a GraphicsPlus object.



Stamp

An element on the Foreground layer of a GraphicsPlus object that combines text with a graphic to send a particular 
message. Intelligent Formatting manages the text size and colors of stamps for you. A stamp can be the only element
in a GraphicsPlus object.



style

    

    

A group of settings that controls details of the appearance of a GraphicsPlus object. Clicking the Style button cycles 
through sets of visual variations for the current layout. The appearance of the Style button changes depending on the 
current layout and what's selected in the object.



sub-point
An element that amplifies or supports the point to which it refers.



Texture

A visual effect that can add interest to the background of a GraphicsPlus object or to certain elements in the object.



Transparent design
The first choice on the Designs tab in the GraphicsPlus Gallery. GraphicsPlus objects with the 
Transparent design do not have a distinctive background; they blend into the host document. By default, 
transparent objects don't have a title, subtitle, lead-in, or remark, but you can add these text elements if 
you want.



variation

A modification of a basic layout type. For example, pie chart variations include layouts for 3-D pie charts, pie charts 
with separated slices, and donut charts.



GraphicsPlus icon

An icon that GraphicsPlus puts in the status area of the Windows 95 taskbar. Double-click the icon to open the 
GraphicsPlus Gallery.



GraphicsPlus object
The intelligently formatted OLE object you can create in a host document. GraphicsPlus objects add 
impact and visual appeal to the documents in which they appear.

Double-click a GraphicsPlus object to activate it. Then use the Gallery to change the object's layout, 
design, and color scheme, or add stamps and textures to the object.



GraphicsPlus window
The window you use to change a GraphicsPlus object that is not edited in place in a host document. You 
can save and print the object using commands available on the menus of this window. 



Contacting Technical Support

If you have a technical problem and you can't find the solution in online Help:

1 Note the sequence of events that led to the problem, and any program messages you see.

2 Contact Technical Support. Have GraphicsPlus running on your computer when you call, and have your 
registration number handy.

Contacting SPC/Serif Technical Support

Our support mission is to provide fast, friendly technical advice and support from a team of on-call experts. SPC/Serif 
customers are entitled to free, unlimited technical support for the first 30 days following receipt of the product. After 
that time, pricing policies (per-call or per-year) go into effect.

To reach SPC/Serif Technical Support:

USA Technical Support

Call (603) 886-6642

E-mail support@serif.com

Europe Technical Support

Call (0115) 9149090

E-mail support@serif.co.uk

Please do not fax technical support queries.

On the World Wide Web, you can check up-to-date technical bulletins at:

http://www.spco.com/techsupp/custmain.htm

Additional SPC/Serif Contact Information

Main office (USA, Canada):

SPC/Serif
PO Box 803
Nashua, NH    03061
USA

Main (603) 889-8650
Registration (800) 794-6876
Sales (800) 55-SERIF or 557-3743
Customer Service (800) 489-6720
General Fax (603) 889-1127
Sales Fax (603) 886-4919

European office (UK, Europe):

SPC/Serif
The Software Centre
PO Box 2000
Nottingham    NG11 7GW
UK

Main (0115) 9142000
Registration (0500) 454645
Sales (0800) 3767070
Customer Service (0115) 9149090
General Fax (0115) 9142020

On-line product and company information:

Internet http://www.spco.com

International Inquiries:

Please contact our main or European offices as appropriate.
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